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Chapter 14 - Portfolios & Transactions 
 

 

 

 

 

 

What you will learn in this chapter: 

 How to create portfolios  

 How to record transactions  

 How to organise multiple portfolios into Group portfolios 

 How to create cash accounts and link them to portfolios 

 How to add dividends to your portfolios automatically 

 How to apply share splits and consolidations 

 How to graph the value or profit of your portfolios 

 How to graph your portfolios against relevant benchmarks. 

 How to monitor your capital gains liability and print reports for each tax 
year to help in completing your tax return. 
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Introduction 

You can create unlimited portfolios in ShareScope. These can be investment portfolios, in which you 
record your transactions, or simply watchlists of instruments you are monitoring. 

Although most brokers will provide you with online access to your transaction history, ShareScope 
provides significantly more functionality with regards to monitoring your performance and managing 
your capital tax liability. 

If you have previously recorded your transactions in a spreadsheet, you can recreate your 
portfolio(s) in ShareScope. 

You manage your investments through the following three views in ShareScope: 

 Portfolio view – list of instruments added to your portfolio.  

 Transaction view – list of the transactions you have recorded for each instrument. 

 Cash Account view – list of cash credits and debits. Can be linked to a portfolio. 
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We’ll cover these in more detail below, including how to navigate between them. 

Multi-currency support 

Before we start learning about portfolios, you’ll need to understand how ShareScope treats 
instruments in different currencies.  

When you create a portfolio in ShareScope, you will choose the portfolio currency. For most 
investors this will be Sterling but you may have investments denominated in Dollars, Euros or other 
currencies.  

You can create portfolios for different currencies if you like but you don’t have to. Whichever 
currency you choose, you can still add instruments which are denominated in a different currency. 
For example, your Sterling portfolio may include shares denominated in Euros and Dollars. 

In the Portfolio view, the latest price of your holdings will be displayed in their native currency but 
the value of your holdings will be displayed in the chosen portfolio currency. This enables a total 
value to be displayed in the Summary line. 

In the Transactions view, you can choose to display your transactions in the native currency or the 

portfolio currency. By default, transactions are displayed in their native currency.  

The Latest line will provide a total in the portfolio currency. 

The same applies to group portfolios where the chosen portfolio currency will override the portfolio 
currencies of the constituent portfolios. 

Create a new portfolio 

To create a new portfolio, click on the Select Portfolio button or press F12. Click on New portfolio 
and name your portfolio.  

The default portfolio currency is Sterling but you can also select Dollars or Euros. If you need to, you 
can add additional currencies to this list - see Add an exchange rate. 

By default, the Enable multi-currency display option is ticked which means that transactions in 
different currencies will be displayed in their original currency.  

If you untick this box, transactions will be displayed in the portfolio currency. You can, however, 
double-click on a transaction to display the details in the original currency. 

You can subsequently change the currency used by a portfolio by right-clicking in the portfolio or 
transaction screens and selecting Portfolio management and then clicking on Set currency.  

When you create a new portfolio you will be given the option to create an attached cash account 
with the same name as the portfolio. 

Once you have created a number of portfolios, you may to organise them into group portfolios. 

You can read below about ShareScope’s Portfolio view after which you will want to add shares or 
other instruments to your portfolio and then record your transactions. Before you record any 
transactions, we recommend you read the section on Cash accounts first. 
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The Portfolio view 

When you create a new portfolio, or view an existing portfolio, the Portfolio view will be displayed. 
This is essentially a variation of the List view which it replaces in the normal view cycling sequence: 

Portfolio -> Graph -> (Intraday graph) -> Details -> 

The only physical difference between the Portfolio view and a normal List view is the Summary bar 
which appears just above the column headings. By default this gives information such as the 
portfolio name, the numbers of shares held, the average share value, total and average 
capitalisation and portfolio currency. You may prefer to use the Investment portfolio summary bar 
which will display the current portfolio value, change in value and profit/loss. To choose this, right-
click in the Portfolio view and select Investment portfolio.  

To change the style and/or position of this Summary bar, or hide it completely, right-click in the 
Portfolio view, select List design and then click on the Other tab. Here, you can also select to use 
intraday prices for the valuations in the Summary bar (if you receive intraday data). 

Like other Lists in ShareScope, you can add and remove columns to display the data of most interest 
to you. You can also add some Transaction columns to the Portfolio view. The majority of these are 
described in Add columns to the Transactions view but the following two columns are worth 
highlighting here: 

Portfolio name – displays the name of the portfolio(s) that include each instrument. 
Particularly useful for Group portfolios. 

Portfolio % - displays what percentage of the current portfolio that each instrument 
represents. 

The general look and feel of the Portfolio view can be customised through the List design option on 
the context menu. 

Add shares to a portfolio (from within a portfolio) 
To add an instrument to a portfolio, from the Portfolio view, simply press the CTRL and A keys 
together. In the dialog box that is displayed, you can search for the instrument. By default, 
ShareScope will search its entire database but you can click on the Find in list button to select a 
narrower list (e.g. FTSE 100 or unit trusts).  

Add shares to a portfolio (when not in the portfolio)  
You can add instruments to a portfolio from the List, Graph, Details, Level 2 and Data Mining views.  

In the Graph, Details and Level 2 views, you can only add the currently displayed instrument.  

In the List and Data Mining views, you can add a single instrument, multiple instruments or all 
instruments. You can also add all instruments above or below a selected instrument. 

You can add the selected instrument(s) to the current portfolio, another portfolio or a new portfolio. 

You can select multiple instruments using the standard Windows SHIFT-click, CTRL-click and click and 
drag commands. 

To add the selected instrument(s) to the current portfolio, simply select the required instrument(s) 
and then press CTRL-A (The CTRL and A keys together).  
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There are a number of context menu options for adding instruments to portfolios and these are 
detailed in the table below. Right-click to display the context menu. 

Command/Menu  Sub-menu View Description 

CTRL-A  List, Graph, 
Details, Level 2 
and Data Mining 

Add selected instrument(s) to the current 
portfolio. 

Add selected 
share(s) to 
portfolio <name> 

 List, Graph, 
Details, Level 2 
and Data Mining 

Add selected instrument(s) to the current 
portfolio. 

Add all shares to 
portfolio <name>. 

 List, Data Mining Add all instruments to the current portfolio. 

Add shares above 
(inc. selected) to 
portfolio <name> 

 List, Data Mining Add all instruments above and including the 
selected share to the current portfolio. 

Add shares above 
(inc. selected) to 
portfolio <name> 

 List, Data Mining Add all instruments below and including the 
selected share to the current portfolio. 

Add to another 
portfolio 

Selected share(s) List, Data Mining Add selected instrument(s) to another 
portfolio or a new portfolio. 

 All shares List, Data Mining Add all instruments to another portfolio or a 
new portfolio. 

 Shares above (inc) List, Data Mining Add all instruments above and including the 
selected share to another portfolio or a new 
portfolio. 

 Shares below (inc) List, Data Mining Add all instruments below and including the 
selected share to another portfolio or a new 
portfolio. 

 
Note: when you add shares to a portfolio from a different view, ShareScope won’t display 
the portfolio afterwards. 

Copy a share to another portfolio 
You can copy an instrument and any associated transactions from one portfolio to another. Click on 
the share in the Portfolio view to select it. Right-click and select Copy share to another portfolio. 
You will be prompted to select the portfolio to copy to. 

Move a share to another portfolio 
You can move an instrument and any associated transactions from one portfolio to another. Click on 
the share in the Portfolio view to select it. Right-click and select Move share to another portfolio. 
You will be prompted to select the portfolio to copy to. 
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Create a group portfolio 
Group portfolios can be used to organise and monitor a number of related portfolios. For example, 
you may have portfolios for different investment strategies, currencies, members of the family, etc. 
Group portfolios can be used to see your total holdings in each instrument or give a total value for 
the constituent portfolios and any linked cash accounts. 

In a Group portfolio, the instruments and transactions of the constituent portfolios are listed 
together. You may wish to add the Portfolio name column to both the Portfolio and Transactions 
views so you can tell which portfolio each holding or transaction belongs to. 

To create a new group portfolio, click on the Select portfolio button, select New group and enter a 
name.  

As with individual portfolios, you will need to choose the portfolio currency (see Multi-currency 
support). This does not change the portfolio currency of the constituent portfolios.  

After selecting the name and currency, a box appears allowing you to choose which portfolios are to 
be included in the group. To include a portfolio in the group, highlight the portfolio name in the left-
hand window then click the single arrow button to move to the right-hand window. To add all your 
portfolios to the group, click the double-arrow button.  

Once created, group portfolios can be identified by the word '[Group]' appearing after the portfolio 
name in the Select portfolio list. Group portfolios also have a unique icon. 

Change the portfolios included in a group portfolio 
Once you have created a group portfolio you can change which portfolios are included by right-
clicking in the Portfolio view and selecting Edit portfolios included from the context menu. 

Cash accounts 

Cash accounts allow you to keep track of cash that is associated with your investments such as funds 
kept in cash, monthly contributions, realised profits and tax rebates. Transactions recorded in your 
portfolios can then be debited from or credited to a cash account.  

You can create cash accounts in different currencies. For example, you could have Sterling, Dollar 
and Euro cash accounts all serving a multi-currency portfolio.  

Cash accounts and portfolios in the same currency can be attached (linked together). This enables 
the value of the cash account(s) to be included in the portfolio valuation. Each cash account can only 
be linked to a single portfolio but you can have multiple cash accounts (up to 30) linked to the same 
portfolio. 

When you create a new portfolio you will be given the option to create an attached cash account 
with the same name as the portfolio. 

You do not have to use cash accounts and you can add them retrospectively. 

Below is a summary of how cash accounts and portfolios can be organised:  

 Scenario 1: Cash account linked to portfolio 

 Scenario 2: Cash account servicing multiple portfolios 

 Scenario 3: Multiple cash accounts linked to portfolio  

 Scenario 4: Multiple cash accounts (multi-currencies) servicing a portfolio  
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Create a Cash Account 
Cash accounts can be created from the Portfolio or Transactions views: right-click and select View 
cash account then Select cash account and finally click on New account. 

To create a new cash account in a new window (Plus/Pro), click on the View menu, then New 
window, then Select cash account, and finally New account.  

In either case, the following dialog box will be displayed: 

 

1. Enter a name for the cash account. 

2. Select the currency for your cash account. By default, Sterling, Euro and Dollar are offered. 
You can add more currencies to this list if required (see Add an exchange rate). 

3. Select Attach to only one portfolio if you want the account to be associated with a single 
portfolio only.  

4. Select the portfolio from the drop-down list underneath. 

5. Click on OK to display the new cash account.  

Right-click in the screen for options to add a debit or credit, edit and delete entries or create, 
rename and delete cash accounts. 

Items here appear in date order with the most recent date at the bottom. You can sort by all 
columns except Balance. Portfolio transactions are sorted by time in cash accounts, so that multiple 
intraday transactions appear in the order in which they were executed. 

Attach an existing cash account to a portfolio 
Attaching a cash account means assigning it exclusively to a single portfolio. Therefore, if it already 
contains details of transactions from other portfolios you will be asked if you want to retain or lose 
these details. Obviously, if you intend to include the balance of the cash account in the portfolio 
valuation, then retaining these details will render the valuation meaningless.  

When you attach a cash account to a portfolio, you will be asked if you want to assign any 
unassigned transactions to the cash account. You can manually assign existing transactions 
afterwards if you are not sure. See Retrospectively assign transactions to a cash account.  

To attach an existing cash account: 

1. Make sure you are in the cash account. 

2. Right-click and select Change attachment. 

3. Click on Attach to only one portfolio and select the required portfolio from the drop-down 
list underneath. 
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4. Click on OK.  

5. Respond as appropriate to any question related to existing transactions in the portfolio or 
cash account. 

Change the portfolio that a cash account is assigned to 
Before you change the portfolio to which a cash account is attached, consider the implications: 
details of all transactions related to the current attached portfolio will be removed from the cash 
account.   

1. Make sure you are in the cash account. 

2. Right-click and select Change attachment. 

3. Choose a different portfolio from the drop-down menu. 

Retrospectively assign transactions to a cash account 
To attach existing share transactions to a cash account, go to the Transactions view of the attached 
portfolio and double-click on the relevant transaction. The Record a transaction dialog will be 
displayed showing the transactions details. You can assign the transaction to a cash account using 
the drop-down menu on the left-hand side. 

Transactions view 

Consider ShareScope’s Portfolio and Transactions views as two sides of the same page. The Portfolio 
view, on the front, is a list of the instruments that you have added to the portfolio. The Transactions 
view, on the back, is a record of your purchases and sales in each instrument, and of dividends 
received. 

If your investments are not held in a tax-free wrapper (like an ISA or SIPP) the Transactions view will 
also help you manage your capital gains tax liability through the tax year and help you complete your 
tax return. 

There are a large number of transaction-related columns you can add to the Transactions view. This 
may seem confusing but they all serve a specific purpose. See Add columns to the Transactions view 
later in this chapter. 

The Transactions view includes a Latest line (summary) for each holding, a Totals line, and a Cash 
account line for any attached cash accounts. Note that the Latest and Cash account lines are only 
displayed when the view is sorted by the Name column. Sort by any other column and they 
disappear. 

If you have a numerical keypad on your keyboard you can quickly switch from the Portfolio view to 
Transactions by pressing the + (plus) key.  Press the – (minus) key or F11 to return to the Portfolio 
view. 
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Record a transaction 

ShareScope enables you to record any type of transaction. In this section we will describe how to 
record a simple purchase or sale of shares or units in a fund. For recording dividends, see Record a 
dividend. For other transaction types, such as purchases of bonds, spread bets or corporate actions 
such as stock splits and consolidations, see Other transaction types.  

You can record a transaction from the Portfolio view or Transactions view. Right-click in the Portfolio 
view and you will find the options for Buy, Sell and Dividend on the context menu. The Transactions 
view menu has the additional options Other transaction and Market orders.  

Selecting any of these options will display the Record a transaction dialog with some of the fields 
pre-selected. You can change the transaction type in this dialog anyway. 

 

1. ShareScope will automatically enter the instrument name, share type, transaction type, 
currency, current price, date and time.  

2. Assign the transaction to a cash account (this is optional). Buy transactions will be debited 
from the cash account; sale transactions will be credited to it. You can only select cash 
accounts in the same currency. 

3. ShareScope will automatically select the native currency of the instrument. You can select a 
different currency if preferred (e.g. the portfolio currency). ShareScope’s multi-currency 
support enables you to record transactions in different currencies. In the Latest and Total 
lines, all values are displayed in the portfolio currency. 

4. Enter the number of shares bought or sold. 

5. Enter any charges incurred. This too is optional but it gives you a complete view of your 
costs and the profitability of your trades. 

6. Amend the date if necessary. 

7. Amend the time if you want/have this level of detail. 



Chapter 14 - Portfolios & Transactions 

 

ShareScope User Guide                Page 10 of 26 

8. You may also add a note (e.g. why you bought or sold the shares) or reference. You can 
display these notes and references in the Transaction view by adding the Note 1 or 
Reference columns.   

9. There are a number of additional options relating to Capital Gains Tax. Click on Show CGT to 
display these. They are described in more detail in Other Transactions: Record a transaction 
– CGT. 

To view your transaction, right-click in the Portfolio view and select Transactions. Alternatively, 
press the + key. 

Customise the Transactions view 

There are seven ways to customise the Transactions view: 

 Add different columns – there are a large number of transaction-related columns you can 
add. See Add columns to the Transaction view below.  

 Use latest intraday prices – if you receive intraday data, you can use the latest prices for 
valuing your holdings. The bid price will be used to value long investments; the offer for 
short positions. Right-click in the Transactions view, select List design and then click on the 
Other tab. 

 Change the style and position of the Summary line, or hide it completely – right-click in the 
Transactions view, select List design and then click on the Other tab. 

 Show/hide total and cash account lines – by default, a total line and a line for each attached 
cash account will be displayed at the foot of your transactions. Right-click in the Transactions 
view, select List design and then click on the Other tab. 

 Show/hide transactions – you can choose to display just the Latest line for each holding. 
Right-click in the Transactions view and select Show latest only. 

 Sort within share – this option enables you to sort per holding using any of the columns in 
your table. In this mode, the Latest lines will remain in view. Right-click in the Transactions 
view and select Sort within share. You will need to re-sort afterwards.  

 Change the font and colours used in the Transactions view - right-click in the Transactions 
view and select List design. 

Add columns to the Transactions view 

There are a large number of transaction-related columns you can add to the Transactions view. This 
may seem confusing but they all serve a specific purpose.  

To add a column to the Transactions view, right-click in the existing column headings and choose 
from the three column submenus: General, Price and Transaction. 

To save space, columns that require no further explanation (e.g. transaction type) have not been 
covered here. Columns that are not related to transactions are covered elsewhere. You can also find 
details in ShareScope’s Help. Position the mouse over a menu item and press F1 to display context-
sensitive help. 
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KEY CONCEPT   When you make multiple purchases of an instrument it is likely that the unit cost 
will be different on each date. For example, you may buy 100 shares at 10p, 100 shares at 11p 
and 100 shares at 12p.  

This has implications for how you calculate your profit. Profit is, of course, the difference 
between the price you paid for the shares and the price you receive for them.  

When you calculate profit for Capital Gains Tax purposes, you are required to use a pooled 
(average) cost. In our simple example above, the pooled cost of a share is 11p.  

An alternative method for calculating profit is to use the first in, first out costing method (or 
FIFO). Again, using our example, if you were to sell 50 shares you would use the cost of the first 
50 shares purchased (10p). If you were to sell 150 shares, your cost would be (100 x 10p) + (50 x 
11p). 

These are simple examples; normally purchase and sales charges would be included in the 
calculation. 

 
Cost and Value columns 
The information you display with regards to the cost and value of your investments can depend on 
personal taste and whether your investments are tax-liable or not. These columns can be found on 
the Add Transaction column menu (with the exception of Price on date which is found on the Add 
Price column menu). 

Note: In V6.20, the Cost/Value column has been renamed Cost/Value (Average). This 
column can sometimes give inaccurate values so we recommend that you substitute this 
column with one of the new columns below. 
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Column Description 

Price per share This column displays the execution buy or sell price of the instrument. 
The Latest line shows the average purchase price. 

Price on date This displays the closing price of the instrument on the date of the 
transaction. The Latest line shows the current price of the instrument. 

Book cost (Pooled) This column displays the costs allocated to each transaction. The costs 
will include charges if recorded. For sale transactions, the cost is the 
original cost of the shares (including charges) based on an averaged 
(pooled) price – as used in CGT calculations. The Latest line for each 
instrument will show the costs associated with your current holdings 
only. If you haven’t sold any of your holdings then the figure will be a 
total of all costs. If you have sold all your holdings, the value will be 
zero.  

Book cost (FIFO) This column displays the same as above but in this case costs are 
calculated on a FIFO basis. 

Total book cost (Pooled) This column is similar to Book cost (Pooled) but shows cumulative 
costs (i.e. the cumulative cost for the most recent transaction will be 
the same as the cost on the Latest line). 

Total book cost (FIFO) This column displays the same as above but in this case costs are 
calculated on a FIFO basis. 

Cost/Value (Pooled) This column displays the cost of buy transactions and the value of 
sales transactions. The value of dividends received is also displayed. 
The Latest line for each instrument will show the costs associated 
with your current holdings on a pooled basis. If you haven’t sold any 
of your holdings then the figure will be a total of all costs. If you have 
sold all your holdings, the value will be zero.  

Cost/Value (FIFO) This column displays the same as above but in this case costs are 
calculated on a FIFO basis. 

Value Displays the value of current holdings based on the current share 
price in the Latest line only. 

Value on any date Enables you to display the value of your holdings on a specific date 
(e.g. the start of the tax year) or to show the price change between 
two dates (e.g. the start of the year and the current day). 

Dividend This column displays the value of any dividends received. The Latest 
line will give a total value. 
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Performance Columns 
In ShareScope you can display the realised profit/loss from your transactions and the unrealised 
(potential) profit/loss on current holdings.  

Most investors will be interested in their profit/loss on a FIFO basis so this is how ShareScope’s 
profit/loss and return columns are calculated. If you wish to see your profit/loss based on a pooled 
cost basis, see the next section on Tax-related Columns. The following profit/loss columns using the 
FIFO costing method can be added from the Add Transaction column submenu: 

Note: if you are using the existing Return % column, we recommend that you replace it with 
one of the new columns below. 

Column Cost method Description 

Realised Profit/Loss    FIFO This column displays the realised profit/loss for each sale 
transaction based on a FIFO (first in, first out) basis. The 
Latest line will display the total including dividends. 
Where charges are recorded they are included in the 
costs.  

Realised Return %       FIFO This column shows the actual return from the shares that 
you have sold and from dividends received. Costs are 
allocated on a FIFO (first in, first out) basis. This column is 
designed as a replacement for the existing Return % 
column. It is important to note that the Latest line 
displays the total realised return as a percentage of your 
total investment in the instrument. 

Unrealised Profit/loss      FIFO This column displays the unrealised profit/loss for 
existing holdings based on a FIFO (first in, first out) basis. 
Where charges are recorded they are included in the 
costs. 

Unrealised Return %      FIFO This shows the unrealised return on your current 
holdings if you sold them at the current closing price. It is 
important to note that the Latest line displays the total 
unrealised return as a percentage of your total 
investment in the instrument. 

Profit/loss FIFO This column displays the realised profit/loss of sale 
transactions and dividends, and the unrealised profit 
from existing holdings. The Latest line totals the realised 
profit and any unrealised profit. Profits are calculated on 
a FIFO basis. 

Total return % FIFO This column combines your realised or unrealised return 
to provide a total % return on the Latest line. Realised 
and unrealised returns are expressed as a percentage of 
the total costs. Returns are calculated on a FIFO basis.  

Annualised return % FIFO Annualised Return shows the average annual return for 
each holding. It combines realised and unrealised returns 
as well as dividends received and is displayed in the 
Latest line only. It averages the return over the period 
between the first purchase and the latest price date.  
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Tax-related Columns 
In order to calculate your capital gains liability, ShareScope can also calculate your profit/loss using 
the pooled cost method. There are three columns you can add from the Add Transaction column 
submenu: 

Column Cost method Description 

CGT before losses      Pooled This column displays the realised capital gain/loss for 
each sale transaction. Double-click on the value to 
display a Capital Gains Report for that share. This 
report will show you how the taxable gains are 
calculated. The Latest line will display the unrealised 
(potential) capital gain/loss if you sold all current 
holdings at the current price. 

CGT after losses       Pooled This column applies, firstly, any losses incurred in the 
current tax year and then, secondly, any losses incurred 
in a previous tax year until the capital gains are brought 
below the threshold. The Latest line will display the 
unrealised (potential) capital gain/loss if you sold all 
current holdings at the current price. Note that you can 
allocate losses from one tax year into another (see 
Losses carried forward below). If you have multiple tax-
liable portfolios, you may consider adding them all to a 
group portfolio in order to calculate your overall tax 
position. 

Annual book gain/loss      Pooled This column displays the realised profit/loss per holding 
on an average cost basis. Effectively, it calculates your 
capital gain/loss. Where you have multiple sales of a 
holding in the same tax year, the annual book/gain loss 
will be displayed against the last transaction. Where 
you have transactions across multiple tax years, a value 
will be displayed for each tax year. Double-click on a 
value to display a Capital Gains report for that holding 
showing how the value was derived. The Latest line will 
display unrealised profit/loss if you sold all current 
holdings at the current price.  

 
NOTE: ShareScope produces two reports to help you complete your tax return. The Capital 
Gains Report details your liabilities for the current tax year (you can view reports for 
previous years as well). This report does not include dividends. A separate Dividends Report 
will detail all dividends received in the current tax year (you can view reports for previous 
years as well). Both reports can be viewed by right-clicking in the Transactions view and 
selecting Capital gains or Dividend report from the menu.  
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Record dividends 

You can add dividend payments to your portfolios manually or ShareScope can do it for you. If the 
latter, you will still retain control over which dividends are added. 

Check for dividends 
You can get ShareScope to check for dividends paid out during a specified time period and add them 
to your portfolio. You can do this on a regular basis to save having to enter them manually. It is 
particularly useful if you have retrospectively recorded a transaction history and need to record the 
dividends received.  

To perform this check on an ad hoc basis, right-click in the Portfolio or Transactions view and select 
Show latest dividends. 

When the check has been performed, ShareScope will display a list of dividends that have been paid 
out by your current holdings in the period checked. You can see an example below: 

 

By default, ShareScope will check the period since you last performed the check. The first time you 
run the check, it will check the period since the last update. If you want to check a shorter or longer 
period, click on the Select date button in the bottom left.  

ShareScope will check your portfolios and exclude any dividends, if any, which have already been 
added. 

ShareScope will add any dividends with a tick next to them. By default, all will be ticked. If there are 
any dividends that you do NOT want to add to your portfolio(s), remove the ticks next to them by 
clicking on them. 

IMPORTANT: If you are sure you do not want to add the unticked dividends, click on the Ignore all 
unticked dividends tickbox. Otherwise, any unticked dividends will be displayed again the next time 
you perform this dividend check.  

You can untick all the dividends by clicking on the None button; you can tick them all by clicking on 
the All button. Click on OK to add the dividends. 

Automatically added dividends can be edited by going to the Transactions view and double-clicking 
on the dividend transaction. For example you may want to assign a cash account or change the tax 
paid on the dividend. If you have a single cash account attached to the portfolio, the dividends will 
be credited automatically. 
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Automatically check for dividends 
You can configure ShareScope to perform the dividend check every time you update. Click on the 
Tools menu, then Options, then the Portfolios & Transactions tab. Click on the Offer to add new 
dividends to Portfolios after update option (it is enabled when ticked).  

Note: this will not work if you have enabled automatic updates.  

Manually record a dividend 
To manually record a dividend payment: 

1. In the Portfolio or Transactions view, click on the relevant instrument, 

2. Right-click and select Dividend from the context menu. 

3. The Record a transaction dialog will be displayed with some of the fields pre-selected.  

4. Set the correct date.  

5. Be careful! ShareScope will automatically enter the current number of shares held. If you 
have recorded multiple purchases of an instrument, and are back-dating dividend payments, 
make sure you enter the correct number of shares held at the ex-dividend date. 

6. You can enter either the total dividend payment received or the amount per share; 
ShareScope will automatically calculate the other. 

7. ShareScope reports dividends net of the 10% tax levied by the UK Government on basic rate 
taxpayers. This is displayed in the Tax rate % field. If you are in a higher tax bracket, or 
receive shares on foreign shares, you may need to change this rate. 

8.  In the Tax credit field, ShareScope calculates the tax you have paid. 

9. You may wish to assign the dividend payment to a cash account. The total amount will be 
credited to the cash account. 

10. Click on OK to add the transaction. 

Other transaction types 

 For buying or selling fixed income instruments, read Transactions in Gilts & 
Corporate Bonds first.  

 If you want to record a spread bet, read Recording Spread Bets beforehand.  

 For recording dividend payments, read Recording Dividends. 

 For pre-recording a market order, see Market orders. 

 For help with other transaction types, such as share splits and consolidations, see 
Other Transaction Types. 
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Transactions in Gilts & Corporate Bonds 
Most sources quote gilt and corporate bond prices as the price per £100 nominal which means that 
the price shown is what £100 purchased at issue is now valued at. However, the nominal price of 
each unit is £1 so the number of units purchased will reflect this. 

For example: you invest £12,500 in a bond quoted at £125 per unit. You have actually bought 10,000 
units (10,000 x £1.25).  

ShareScope will always display the Price per £100 nominal but it enables you to enter the 
transaction at the price per £1 nominal if preferred. 

In the Record a transaction dialog, a button will appear next to the Price per share field. The default 
option is Price per £100 nominal. Using the above example, in this mode you would enter the price 
as £125 and the number of units as 100. 

However, if you click on the button it will change to Price per £1 nominal. In this mode, you would 
enter the purchase price as £1.25 and the number of units as 10,000. 

Once entered you can toggle the button and the price and number will change accordingly. 

Record Spread Bets 
There are two things to consider when entering spread bet transactions into ShareScope. The first is 
with spread bets on rolling spreads – these are generally closed out each evening and re-opened the 
next day.  To mirror your profit/loss from your spread betting account you may want to enter a 
buy/sell transaction each day to show the profit/loss for each day.  Alternatively you can just enter 
the initial buy/sell and wait until you’ve closed the bet before closing the transaction in ShareScope. 

The second consideration you need to make is in relation to entering spread bets on future 
contracts.  ShareScope does not include any future pricing on shares, and only minimal pricing on 
index futures.  As such you will either need to create new shares in ShareScope to record the 
transactions against, or be aware that if you use the cash instrument then any unrealised profit/loss 
will not accurately reflect what your spread bet account is telling you. 

When entering your transaction you need to know three things: 

1. the price bet per point 

2. the value of a point 

3. the buy/sell price 

The amount you bet per point is entered in the transaction as the number of shares purchased.  
However, the exact amount to enter here depends on the value of a point of the instrument bet on. 

For shares, the value of a point is normally equal to one pence/cent.  For most indices, a one point 
movement is a change in value of 1. For exchange rates it can vary, so one point may be a movement 
of 0.0001 in the exchange rate. 

A bet of £5 per point on a share is equivalent to 500 shares (i.e. if the share price goes up 1p, you 
gain 500 x 1p = 500p). 
A bet of £5 per point on an index would be equivalent to 5 shares. 
A bet of £5 per point on GBPUSD would be equivalent to 5,000,000 shares 

When recording the transaction, work out the correct number of shares based on the value of a 
point and the price you’ve bet per point.  Record your buy/sell price as the price per share, and all 
other fields except the date and possibly the time are irrelevant. 
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To make adjustments for financing, use the Other cost or Other return transaction which will adjust 
your profit/loss accordingly. 

Note: If you enter a transaction to sell shares that you do not already own, ShareScope will 
treat this as a short position. Subsequently buying any number of shares up to the quantity 
shorted will be treated as covering all or part of the position. 

Market Orders 
Market orders are transaction types offered by most brokers. They enable you to place an order to 
buy or sell at the current best bid or offer, or to specify a price limit. That is, when you place the 
order you will not know the exact execution price. You may use these order types when placing an 
order with your broker outside of trading hours.  

ShareScope enables you to add market order transactions to your portfolio. To do this, select the 
instrument in the Transactions view, right-click and select Market orders. Choose the required 
transaction type from the sub-menu. The minimum information you need to provide is the number 
of shares. You can enter an expected/target price but this is optional.  

Market orders have no effect on the value of your portfolio until you confirm the transaction. To do 
this, double-click on the transaction to edit it. Change the Transaction type to Buy or Sell (as 
appropriate) and enter the execution price of the shares.  

Other Transaction Types 
You can record the following transaction types by right-clicking in the Transactions view and 
selecting Other transaction.  

Take up rights  Take up the right to buy shares at a special price. Recorded similar to a 
normal buy transaction.  

Sell nil paid rights  Sell the right to acquire shares at a special price. Record similar to a sell 
transaction but doesn’t reduce the number of shares held. 

Scrip dividend  Acquire shares in lieu of a dividend. You simply need to add the number of 
shares and the date. The total value of the shares will be treated as profit. 

Initial payment  Where shares are paid for in instalments (e.g. in a privatisation). Enter the 
number of shares, the date and the initial payment. 

Part payment  Subsequent to an Initial payment, you can record additional part payments. 
Must record an initial part payment transaction or ShareScope will not 
associate the payments together or include the amount in your costs. 

Share split  Adjust your previous transactions for a share split. Enter the adjustment 
ratio or the number of shares now held. 

Share consolidation  Adjust your previous transactions for a share consolidation. Enter the 
adjustment ratio or the number of shares now held. 

Other acquisition  Use this for any other type of share acquisition (e.g. scrip issues, free shares, 
options). 

Other disposal  Use this for any other disposal of shares (e.g. gifts) 

Other return  Use this to record any other receipts (e.g. tax rebates, bonuses). 

Other cost  For example: annual broker costs, subscriptions. The minimum you need to 
enter is the value of the cost. 
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Record a transaction - CGT 
When you record a transaction, there are a number of additional options relevant to investors who 
are liable for capital gains tax. To view these options, click on the Show CGT button in the Record a 
transaction dialog. 

You can set the transaction to be ignored or partially ignored when calculating CGT.  This might 
typically be if roll-over relief is applicable. 

A receipt can be treated as a 'small receipt' if it is less than 5% of the value or less than £3,000.  It is 
then subtracted from the cost base of the share.  

If shares are held prior to 6th April 1982 they can be revalued to their value on 30th March 1982. 

Universal rebase is an irrevocable election option to use the cost base for all shares held on 6th April 
1982 as their value on 30th March 1982. 

Navigation between portfolios, transactions & cash accounts 

KEY CONCEPT: In ShareScope, the last portfolio you looked at is referred to as the Current 
portfolio. If you only have one portfolio, the current portfolio will always be this one. In any 
view, pressing the F11 button will display the current portfolio. Likewise, the last cash 
account you looked at is called the Current cash account. 

You can navigate between portfolios, transactions and cash accounts with the keyboard shortcuts 
shown in the diagram below. If you use Portfolios often, you might also like to add the toolbar 
buttons for these actions: 

 

To add buttons to a toolbar, see Customising Toolbars. You’ll find all these buttons on the View tab. 
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Manage your Capital Gains Tax 

 ShareScope enables you to view and print capital gains reports for the current tax year or any other 
tax year for which you have recorded transactions. You can factor in a single CGT allowance, add a 
spouse’s allowance, ignore the allowance and carry losses forward. 

Capital gains reports are generated per portfolio. To get an overall tax position, you may prefer to 
put all your portfolios into a group portfolio before generating the report.  

Capital gains reports do not include dividends. A separate Dividends Report details all dividends 
received in the specified tax year. Right-click in the Transactions view and select Dividend report. 

You can also create a report for a specific holding within a portfolio or for the entire history of a 
portfolio. 

To generate a capital gains report, right-click in the Transactions view and select Capital gains. From 
the sub-menu select the type of report you want. A dialog will be displayed containing the report 
which you can choose to print. 

Capital gains allowance 
By default, ShareScope assumes that you have no other income which attracts capital gains tax (i.e. 
it will allocate liabilities only after the capital gains threshold has been exceeded). You can choose to 
ignore the threshold, if you have already exceeded it, or to add a spouse’s allowance if applicable. 

In the capital gains report, click on the Summary button to see a summary of your tax position for 
the year or to change how your CGT threshold is treated. 

Losses carried forward 
For Capital Gains Tax purposes, any losses occurring in a tax year are offset against gains in the same 
tax year.  Where the gains are below the threshold, any remaining losses are automatically carried 
forward by ShareScope to the next tax year. 

When completing the Capital Gains section of your tax return, there may be other factors that 
impact on your overall loss amount for the year (for example, if you’ve sold any property in the same 
year). 

If your losses carried forward amount is affected, you are able to manually adjust the figure in 
ShareScope so that the correct loss amount is carried forward to the next tax year. 

Right click in the Transactions view, go to Capital Gains and select Adjust losses. 

If losses are already recorded you will see the amount of the loss being carried forward beside the 
tax year it will be applied to.  For example, if you incurred a loss in the 2009/2010 tax year of £1,050 
which has been carried forward to the next tax year, then your Losses carried forward dialog will 
show ‘Year 2010/2011 £1,050’. 

If you’d calculated the actual loss to be carried forward to the 2010/2011 as a different amount, say 
£2,200, you need to type this into the Override box for the 2009/2010 tax year. 
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Monitor the performance of your portfolio 

Your portfolios will show the realised and unrealised return from your individual investments and 
the current value of your holdings and cash. ShareScope also enables you to find the value of your 
portfolio on a specific date (e.g. the end of the calendar year or tax year), graph your portfolio, 
compare it to a benchmark index, and analyse the sector diversification of your equity holdings. 

Find the value of a portfolio on a specific date 
Right-click in the Portfolio view and select Value at a date. In the dialog box that appears, click on 
the Dates button and set the required date. The value of all holdings held on that date and any 
attached cash accounts will be displayed. Alternatively, you could add the Value on any date column 
to the Portfolio or Transactions view. 

Graph a portfolio  
You can graph a portfolio in four ways: 

 Graph value – displays a graph of the value of your portfolio since the date of the first 
recorded transaction. The value will be based on realised and unrealised profit (loss). The 
value of any foreign currency holdings or profits will be converted using the daily exchange 
rate.  

 Graph profit – similar to above but graphs the daily profit (loss) since the date of the first 
transaction recorded in the portfolio. 

 Graph shares (weighted by cap.) – effectively creates an index comprising the shares in your 
portfolio weighted by capitalisation. The effect of weighting is that the price movement of 
larger companies has more effect than the price movement of smaller companies. 

 Graph shares (not weighted) - creates an index comprising the shares in your portfolio 
weighted by last percentage price change.  

All graphs are displayed as a closing price line. All four graphs are available on the Portfolio context 
menu; the Graph value and Graph profit options are also available on the Transactions context 
menu. You can apply any of your Graph settings or create a new one specifically for portfolios. 

Measure your portfolio against a benchmark 
Most investors aim to beat the market (i.e. a suitable benchmark index). For example, if you invest in 
large-cap UK shares your benchmark would probably be the FTSE 100. It may be appropriate to use a 
different benchmark for each of your portfolios. In ShareScope it is easy to graph your portfolio 
against another index or instrument. 

You can either do a simple overlay where the benchmark index is rebased to the starting point of 
your portfolio graph, or you can draw the percentage performance of your portfolio against the 
selected benchmark. The screen shots below illustrate the difference between the two graph types. 
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Benchmark index overlaid on portfolio graph        Portfolio performance relative to benchmark index  
            (with original graph shown) 

In your portfolio graph, right-click and select Additional graphs from the context menu. In the dialog 
box that appears, click on Add. 

If you want to add a simple overlay, select Add a share or index and then search for the index or 
instrument required. If you are looking for an index, click on the Find in list button and select the 
Indices list. If you want to add the FTSE 100, select Add FTSE 100 from the menu instead. 

Note: you can also use this feature to graph a portfolio against the benchmark index. 

If you want to show the percentage performance, click on the Add button and then select Price 
relative to. Again, you will need to select the index or instrument to compare your performance 
against. You will be asked to select the colour and style of the graph. You’ll notice on the screen shot 
above that ShareScope leaves the original portfolio graph on the price relative graph. This can look 
messy if the two graphs overlay each other. Remove the original graph by clicking on the Tools 
menu, then Options, then the Graph tab and de-selecting Show original and deflated. You’ll get 
something like this: 

   
Portfolio performance relative to benchmark index 
(with original graph removed) 
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Portfolio diversification 
The Sector Analysis dialog box offers a breakdown by sector of the shares within a list or portfolio. 

Note: this analysis will only cover company shares. It will not cover unit trusts/OEICs, bonds 
or foreign exchange. Investment trusts will be classified as Equity investment instruments 
and exchange traded funds (ETFs) will be classified as Non-equity investment instruments. 

For an ordinary list, company capitalisation is broken down by industry, sector, subsector, 
supersector or company and may be displayed as a pie chart or as a grouped list. 

For a portfolio, either capitalisation or the size of your holding in each share may be broken down by 
industry, supersector, sector, subsector or company. Again, this breakdown may be displayed as a 
pie chart or as a grouped list. 

You can therefore use this option to view the importance of an individual share or sector within the 
list you are currently viewing. You can also use this option to view the spread of your holdings across 
a variety of sectors, analysing the balance and risks involved in your portfolio. 

Pie charts may be displayed with or without a legend, in a 3D view, or flat, and may be printed. The 
colours used for an individual pie chart may be edited by clicking on the legend colour buttons. 

Grouped lists may be sorted within each sector-based group on name, capitalisation/holding size, or 
percentage. In order to perform a sort (or reverse the sort order), you simply need to left-click on 
the relevant column heading. 

Portfolio management 

ShareScope provides a suite of tools for managing your portfolios. These can be accessed by right-
clicking in the Portfolio or Transactions views and selecting Portfolio management. 

You’ll notice that it is actually an expansion of the Select portfolio dialog. Clicking on the More >> 
button in this dialog will reveal the same options. 

The Expand folders and Collapse folders buttons enable you to open or close any folders you have 
created. 

Select the required portfolio before clicking on any of the other options. You can select multiple 
portfolios for Move, Delete and Revert to saved operations using the standard Windows SHIFT-click 
and CTRL-click. 

To create a new folder, select a portfolio and click on the Move to folder button. You will be able to 
select an existing folder or create a new one.  

If you want to create a new folder inside an existing folder, click on the folder first and then select 
New folder. This will enter the correct path name in the portfolio folder name field. Alternatively, 
enter the path name in the format:  

folder1\folder2\newfilename  

The Revert to saved button returns the currently selected portfolio to its last saved status. 
ShareScope saves your changes when you close the program down, perform an update, or click on 
Save on the File menu. 



Chapter 14 - Portfolios & Transactions 

 

ShareScope User Guide                Page 24 of 26 

The Set currency button enables you to change the currency of the currently selected portfolio. If 
you want to set the currency to anything other than Sterling, Dollar or Euro, see Add an exchange 
rate. 

The Edit group button only becomes active when you have selected a Group portfolio. It enables you 
to change the constituent portfolios.  

The Options button is the same dialog accessed via Tools -> Options -> Portfolios & Transactions 
and is covered in the section Portfolio Options. 

Add an exchange rate 
ShareScope first converts a currency into US Dollars and then into Sterling. This is simply because it 
has more USD foreign exchange pairs than Sterling. If ShareScope already includes the exchange rate 
between the desired currency and the Dollar, you can use this. If not, you will need to manually add 
it. For example, if the instrument was priced in Thai Baht (THB), you would need to add the USD/THB 
exchange rate. 

To add an exchange rate: 

1. Click on the Tools menu. 
2. Click on Options. 
3. Click on the Currencies tab.  
4. Click on Show all to display all currencies.  
5. Scroll down to find the required currency and then double-click on it. An Edit button will 

appear – click on this.  
6. If ShareScope does not provide an exchange rate for this currency, click on Fixed rate and 

enter a value in the box provided.  
7. If ShareScope does provide an exchange rate for this currency, select Use data from this item 

and then click on Not set. Search for the currency pair (e.g. USDCHF). 
8. Click on Include in my list of selected currencies. 
9. Click on OK. 
10. Click on OK.  

If you have added the exchange rate manually, you can update it whenever you like by repeating the 
process above.  

If you are likely to be a regular and/or long-term holder of shares in the currency, you should 
consider adding the foreign currency pair as an instrument and maintaining the exchange rate on a 
daily or weekly basis. See Add a new currency pair. 

Add a new currency pair 
New instruments can be entered manually into ShareScope. This is useful if you want to add an 
investment, index or exchange rate not included in ShareScope. These manually entered instruments 
are termed imported data. 

From the Edit menu, choose Add new data. 

Enter the share name and any other fundamental information you wish.  

Go to the Share Price tab and enter price data by double-clicking on the relevant cell. Prices should 
be entered in the minor currency unit (e.g. pence).  

You may enter as much or as little data as you wish. You may use the built-in tools to adjust all prices 
by a factor, interpolate between figures and detect price glitches. 

javascript:BSSCPopup('HIDD_ANOMALIES.htm');
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You can also use the dialog to add OHLCV data manually by deselecting Display Close Only. You can 
use the Tab key to move between values. Esc cancels the current edit. 

Once done, click OK and the new item will then appear in the All list where you will be able to find it 
and add it to a portfolio in the usual way. You can also see a list of imported data only by selecting 
Imported data from the View menu, or by pressing Shift + F11. Double-click on an imported 
instrument to edit it (e.g. to add the latest price). 

Note that imported data has a different colour in Lists - this is to distinguish it from data supplied by 
Ionic Information Ltd (which cannot be edited). 

Portfolio options 

There are a number of global settings for portfolios which you can change. Some of these have been 
described in context elsewhere. These options can be found in two ways: 

Right-click in the Portfolio or Transactions views, select Portfolio management and then click on the 
Options button. 

Click on the Tools menu, then Options and then on Portfolios & transactions. 

 

 You can select to have balances of cash accounts included in the portfolio valuation figures 
(the cash accounts must first be attached to the portfolios); 

 Select Offer to add new dividends to Portfolios after update if you would like ShareScope to 
alert you to new dividends automatically and to add them to your portfolio if desired. See 
Record Dividends for more details. 

 Display a warning when adding shares to a portfolio. You have three options: no warning, 
always warn or customise warning. If the latter option is selected, ShareScope warns you 
only if the number to be added is more than the level you set; 
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 You can decide how expenses (charges) are recording for transactions. Show expenses 
displays one general expense field whereas Show all expenses shows separate broker, levy 
and stamp duty charges; 

 You can choose when the currency is displayed in the portfolio/transaction summary line 
and dialogs. 

 You can change the look-back period for ShareScope’s New Highs and New Lows portfolios. 

Portfolio flags 

Once you have created one or more portfolios, you can use Portfolio Flags in List, Graph and Level 2 
views to remind you which instruments you hold. Holding the mouse cursor over a Portfolio flag will 
reveal the names of the portfolios in which you hold the instrument. 

In the List view, right-click in the column headings and select Add General column. From the sub-
menu select Flags and in the dialog box displayed select Is a member of a portfolio.  

In the Graph view, right-click in the graph and select Graph design. On the Lines & text tab, click on 
the Edit button and then select Is a member of a portfolio. The flag will appear next to the name of 
the instrument at the top of the graph. 

In the Level 2 view, right-click and select Level 2 design. On the Main display tab, click on the Flags 
button and select Is a member of a portfolio. The flag will appear next to the name of the share. 

Note: A flag will appear next to any instrument you have added to a portfolio; you do not 
need to be holding any units of the instrument. 

Portfolio news 

You can view news stories for just the shares in a portfolio. Right-click in the portfolio and select 
Portfolio news.  

By default, ShareScope looks back a week but you can change this by right-clicking in the News view 
and selecting News options. You may also like to see only the news for the current day. Right-click in 
the News view and select Today’s news only. For more help with News windows, see the chapter on 
News. 

Press F11 to return to the portfolio view. 

Portfolio alarms 

You can set end of day or intraday alarms (ShareScope Plus and Pro only) for a portfolio. You set 
these in exactly the same way as you do for an individual instrument, using the Alarms wizard, but 
ShareScope will check each instrument in the portfolio to see if it has triggered the alarm conditions. 

From the portfolio view, click on the Edit menu and select Set an end-of-day alarm for <portfolio 
name> or Set an intraday alarm for <portfolio name>. 


